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GxLink is a powerful application that can be installed in Windows OS system and used to interface communication 
between one or more MetLogix Gx200 readouts and the computer. This connection is established via a wired or 
wireless network connection. Once connected, measurement results can be transferred from the Gx200 to the GxLink 
application over the network. 

What Can You Do With GxLink? 
The GxLink application allows users to configure one or more 
Gx200 devices to send a measurement results file, in CSV or TSV 
format, directly to a specified folder on the target PC. This folder can 
be local to the GxLink PC, or a mapped network folder, accessible 
by the GxLink PC. Data received in the GxLink application will be 
displayed in a separate tabbed window for each device that is 
connected. This data can then be sent directly to a Microsoft Excel 
sheet, or it can be copied to, and pasted from, the Windows 
clipboard.  

Using the GxLink 
To use the GxLink application with a Gx200 readout, the GxLink software must be installed on a computer running the 
Windows operating system. The computer should also be connected to a local network via a wired or wireless network 
device.  

 
To send data from an Gx200 to an instance of the GxLink software, the Gx200 must have GxLink enabled in setup and 
the readout connected to a network.  

Setting up the GxLink application 
With the Gx200 readout connected to the PC’s network and the GxLink option enabled in Setup, connecting one or 
more readouts to the GxLink application is accomplished by Discovering the readout from the Devices setup page in 
the GxLink software. The devices are identified by their serial number. To connect to a specific Gx200 readout, highlight 
the target device and then press the Connect button. This process can be summarized as:  

1 Press the Discover button to locate and list all the Gx200 connected to the network (if the 
target device is not already listed). The target readout will now be listed. Alternatively, use the 
Add button to add to the list the target Gx200 readout if the IP address is known. 

2 Rename the target device to a more meaningful name, if desired, by double-clicking on the name field of the 
target device and typing in the new name. Then press the ENTER key on the PC. 

3 Highlight the target device and press the Connect button. The status of the device in the list 
will change from Not connected to Connected.  

 

Introduction 
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NOTE 
If the device discovery fails to successfully locate target readout, verify that the Gx200 is connected to a network. 
If the Gx200 is discovered but fails to connect, verify that a valid IP address is reported in the Export setup menu 
(Setup -> Export). 
 

 

Setting target directory 
A local or networked directory can be set on the computer to save the transferred data files. The GxLink sets the default 
to directory to a subdirectory called GxLink in the current Setup documents directory. To set the default to a different 
directory:  

1 Highlight the target device in the Devices tab list then press the Set Dir button.  
2 Browse to the target directory using Windows files explorer.  
3 Select the desired directory and press the OK button. The path to the 

selected directory will be shown on the Folder field of the device. 
 

The Open Dir button can be used to open the directory assigned to the currently selected Gx200 device. 

Data Operations 
Each connected Gx200 device has its own data tab within the GxLink main window. If the tab of a connected Gx200 
readout is not open, double-clicking on the device in the device list will open the tab. 

Device data tab 
The device data tab contains the name of the device in the tab title, a set of data columns and tab manipulation buttons. 
The column names are set automatically to the data that has been imported into GxLink application. The tab 
manipulation buttons include: 

• Close button – Used to close the tab.  
• Clear button – Clears the contents of the tab when pressed. 
• Export button – Opens an Excel sheet and posts the 

current tab data. 
• Get Records button – Requests new data records from the 

Gx200 device associated with that data tab.  
 

A device data tab can be dragged out of the main GxLink window, 
creating its own standalone window. The individual device windows 
can be recombined with the GxLink application by dragging them 
back in, next to the existing tabs. 

Sending Gx200 Data to GxLink 
Data is sent to GxLink using the Export Data function in Gx200 or by requesting new data from GxLink 
using the Get Records button. Received data is formatted according to the selected setting in the 
Export setup page of the Gx200. 
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NOTE 
When data is sent from an Gx200 to the GxLink application, only the most recently transferred data will be 
displayed in the corresponding device tab and a file is saved in the assigned target directory. When new data is 
received from the Gx200, it replaces currently displayed data, and a new file is saved in the assigned directory. 
 

Copy/Paste 
Results rows within the tab views can be selected using the left mouse button. Selected data rows can be copied to 
the Windows clipboard according to standard windows convention.  

Sortable columns   
Ordered sorting of the data columns can be achieved by clicking on the column header label. Column contents will be 
toggled between ascending and descending order. 

Send selected data to Excel 
Selected rows in the tabbed view can be sent directly to Microsoft Excel. This feature requires that Microsoft Excel is 
installed on, and licensed to, the same computer the GxLink is running on. Select the rows of data you would like to 
send and press the Export button. Pressing the Export button with no rows selected will send the entire contents of 
the data tab. 

Gx200 Simulator 
GxLink contains a simulator function that emulates Gx200 functions. The Gx200 simulator is a powerful tool that can 
be used to set up the Gx200 readout, test formulas and emulate input and output operations. The simulator contains 
most functions found in the Gx200. 

Get Settings 
Before starting to use the simulator, connect to a target Gx200 readout by following the steps above. 
Once GxLink and the target Gx200 device are communicating, highlight the target Gx200 device in the 
list and then press the Get Settings button to fetch its current settings. 

Using the Simulator 
To use the simulator, press the 
Simulator button. A Gx200-like 
application will open with settings and parts of the target 
Gx200 readout. If this is the first time the simulator is being 
used on the PC, GxLink will prompt for the installation of the 
simulator. Select YES to continue with the installation or NO 
to cancel. Ensure the Launch after installation checkbox is 
checked. Otherwise, press the Simulator button again. Once 
the simulator is running, perform settings and parts edits as 
desired. 
 
 
 
 
 

 

NOTE 
The simulator MUST first be installed on the PC before it can be used.  
Exporting/importing settings/parts from/into the simulator, the default location is the Gx200_Exports subfolder 
of the Documents system folder. So, to import a part/settings into the simulator, the part/settings file must be 
copied into the Gx200_Export subfolder. 
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Sending Settings 
After making changes to settings and parts in the simulator, test the workflow to ensure they perform the desired 
operations. Once satisfied with the changes, you can send the edited settings and parts back to the target Gx200 or to 
a different unit that is in the list and currently connected, by highlighting the unit in the list and pressing the Send 
Settings button. The simulator will close, and a message will be displayed showing the result of the 
settings and parts transmission to the selected device. 

Part Graphical Editor 
It may be necessary to prompt the readout operator on how to place the part under measure into the gage fixture using 
visual cues. This can be accomplished using the intuitive Graphic gage type display. To design the graphical gage, 
use the Part Graphical Editor in GxLink. To use the Part Graphical Editor, follow these steps:  

1 Run GxLink and connect to a target Gx200 readout. 
2 Highlight the target Gx200 readout and then press the Part Graphical Editor 

button. A tab named Gx200 Graphical Editor: <Readout name> will open. 

Gx200 Graphical Editor tab 
The Gx200 Graphical Editor tab contains the name of the device in the tab title, an image marking area, a parts 
dropdown list field, a dimensions column, and tab manipulation buttons. The tab manipulation buttons include: 

• Close button – Used to close the tab.  
• Clear button – Clears the contents of the tab when pressed. 
• Get Parts button – Gets all parts in target Gx200 readout.  
• Open Image button – Opens Windows file browser for 

browsing to an image to be used. 
• Crop button – Crops the image to the size of bounding 

square.  
• Save to Gx button – Saves the graphical data to the Gx200 

device associated with the tab.  

Marking the Part Graphics 
The first step to marking a part graphics is to get the parts from the Gx200 device. Press the Get Parts button to get 
the parts. Then: 

1 Select the desired part from the dropdown list. 
2 Press the Open Image button and browse to the desired image. 
3 Resize and move the marquee bounding square to include the 

desired regions of the image. 
4 Press the Crop button to crop the image under the square. 
5 Add dimensions information to the image by selecting the 

dimension and clicking on the image. 
6 Drag the dimension to reposition on the image as desired. 
7 Once done, press the Save to Gx button to send the information 

back to the Gx200 device. 
8 To display the graphic on the Gx200 device, set the part gauges 

field to Graphic. 
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Additional Functions 
Listed below are some additional settings and controls in the GxLink software: 

View menu 
Select the corresponding item from the view menu to add a new tab for the File Log and Devices if the tab has been 
dragged out. Otherwise, it brings the tab to the forefront. 

Tools menu 
The GxLink software contains tools to restore the previous status of the unit. The submenu tools include: 

•  Simulator – This menu item opens the simulator using the settings from previous session unlike when opening 
it using the Simulator button. If it is the first time, the simulator will start with default settings. 

•  Backup – The backup function gets settings and parts from the connected Gx200 and saves them to the PC.  
•  Restore – The restore function loads the connected Gx200 with unmodified settings and parts. These 

configuration parameters are from the last backup.  

Options menu 
The Options menu provides a way to set the preferences for the GxLink application. The submenu include: 

•  Launch on Startup – When checked, GxLink will launch when Windows OS starts. 
•  Language – Brings up a language selection dialog. Select the desired language and press the OK button. The 

application restarts to apply the language change.  

Help menu 
Access a copy of the User and Setup guide in PDF format by selecting the Help… item from the Help menu. Software 
version information can be found in the Help -> About menu item. 
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File Log 
A tab displaying a history of all transferred data files from connected Gx200 devices to the GxLink application. The file 
log is cleared on program shutdown.  

Run in the Background  
The GxLink application can be minimized to the Windows Taskbar system tray. The application can be restored by 
single-clicking the tray icon. The application can be closed by right clicking on this tray icon. When exiting the 
application, you will be given the option to run in the background, close the application entirely, or to return to the 
GxLink window.  



 

 

 
 
 
 
 

This product is warranted against defects in workmanship, material, and design for two (2) years from date of 
delivery to the extent that METLOGIX will, at its sole option, repair or replace the product or any part thereof which is 
defective, provided, however, that this warranty shall not apply to products subjected to tampering or, abuse, or 
exposed to highly corrosive conditions. 
 
THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IMPLIED AND 
METLOGIX HEREBY DISCLAIMS ALL OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE OR MERCHANTABILITY. METLOGIX SHALL NOT BE 
LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, INCLUDING, BUT NOT LIMITED TO, ANY 
ANTICIPATED OR LOST PROFITS. 
 
This warranty is voidable if the purchaser fails to follow any and all instructions, warnings or cautions in the product’s 
Instruction Manual. 
 
If a manufacturing defect is found, METLOGIX will replace or repair the product or replace any defective part thereof 
without charge; however, METLOGIX’s obligation hereunder does not include the cost of transportation which must 
be borne by the customer. METLOGIX assumes no responsibility for damage in transit, and any claims for such 
damage should be presented to the carrier by the purchaser. 
 

  

Product Warranty 



 

 

SOFTWARE LICENSE AGREEMENT 
NOTICE TO USER: PLEASE READ THIS AGREEMENT CAREFULLY.  BY COPYING, INSTALLING, OR USING ALL OR ANY 
PORTION OF THE SOFTWARE, YOU ACCEPT ALL TERMS AND CONDITIONS OF THIS AGREEMENT, INCLUDING, IN 
PARTICULAR THE PROVISIONS ON:  TRANSFERABILITY IN SECTION 4; WARRANTY IN SECTIONS 6 AND 7; AND 
LIABILITY IN SECTION 8. YOU AGREE THAT THIS AGREEMENT IS LIKE ANY WRITTEN NEGOTIATED AGREEMENT 
SIGNED BY YOU.  THIS AGREEMENT IS ENFORCEABLE AGAINST YOU AND ANY LEGAL ENTITY THAT OBTAINED THE 
SOFTWARE AND ON WHOSE BEHALF IT IS USED; FOR EXAMPLE, IF APPLICABLE, YOUR EMPLOYER.  IF YOU DO NOT 
AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE THIS SOFTWARE. 
 
METLOGIX AND ITS SUPPLIERS OWN ALL INTELLECTUAL PROPERTY IN THE SOFTWARE.  THE SOFTWARE IS 
LICENSED, NOT SOLD.  METLOGIX PERMITS YOU TO COPY, DOWNLOAD, INSTALL, USE, OR OTHERWISE BENEFIT 
FROM THE FUNCTIONALITY OR INTELLECTUAL PROPERTY OF THE SOFTWARE ONLY IN ACCORDANCE WITH THE 
TERMS OF THIS AGREEMENT.  USE OF SOME METLOGIX AND SOME NON-METLOGIX MATERIALS AND SERVICES 
INCLUDED IN OR ACCESSED THROUGH THE SOFTWARE MAY BE SUBJECT TO OTHER TERMS AND CONDITIONS 
TYPICALLY FOUND IN A SEPARATE LICENSE AGREEMENT, TERM OF USE OR “READ ME” FILE LOCATED WITHIN OR 
NEAR SUCH MATERIALS AND SERVICES. 
 
 
THE SOFTWARE MAY INCLUDE TECHNOLOGY DESIGNED TO PREVENT UNAUTHORIZED USE AND COPYING.  THIS 
TECHNOLOGY MAY CAUSE YOUR COMPUTER TO CONNECT TO THE INTERNET WITHOUT NOTICE ON INSTALL, 
LAUNCH, AND ON AN INTERMITTENT OR REGULAR BASIS THEREAFTER.  ONCE CONNECTED, THE SOFTWARE WILL 
TRANSMIT INFORMATION TO METLOGIX VIA AN INTERNET CONNECTION.  METLOGIX MAY USE THE TRANSMITTED 
INFORMATION, AS WELL AS OTHER INFORMATION YOU OUR THIRD PARTIES MAY PROVIDE TO US, TO DETECT OR 
PREVENT USE OF METLOGIX SOFTWARE THIS IS FRAUDULENT, NOT VALIDLY LICENSED, OR NOT USED IN 
ACCORDANCE WITH A VALID LICENSE.  SOFTWARE THAT FAILS TO CONNECTO TO METLOGIX AND SOFTWARE THAT 
CONNECTS TO METLOGIX WHOSE USE IS FOUND TO NOT TO BE PERMITTED MAY OFFER ONLY LIMITED 
FUNCTIONALITY OR MAY NOT OPERATE AT ALL. 

1.  Definitions 
“MetLogix” means MetLogix, Incorporated, a Delaware corporation, 175 Canal Street, Manchester, New Hampshire 03101. 
 
“MetLogix Runtime(s)” means MetLogix GX200, MetLogix GX200, MetLogix M1, MetLogix L3, MetLogix L2, MetLogix L1, 
MetLogix Test Builder, or MetLogix CFR21. 
 
“Computer” means a virtual or physical computer device that accepts information in digital or similar form and manipulates it for a 
specific result based on a sequence of instructions. 
 
“Internal Network” means a private, proprietary network resource accessible only by employees and individual contractors (i.e., 
temporary employees) or a specific corporation or similar business entity.  Internal Network does not include portions of the 
Internet or any other network community open to the public, such as membership or subscription driven groups, associations, and 
similar organizations. 
 
“Output File” means an output file you created with the Software. 
 
“Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume license) granted by MetLogix. 
 
“Software” means (a) all of the information with which this agreement is provided, including but not limited to: (i) all software files 
and other computer information.   

2.  Software License 
If you obtained the Software and any required serial number(s) from MetLogix or one of its authorized licensees 
(resellers) and as long as you comply with the terms of this Agreement, MetLogix grants you a non-exclusive license 
to install and use the Software in a manner consistent with its design and Documentation and as further set forth 
below. 



 

 

2.1  Limited Use 

    2.1.1 
The Software, or portions of the Software, may allow installation and use without a serial number.  If so, you 
may install but not use such non-serialized Software on any number of Computers as part of an 
organizational deployment plan.  Further, you may install and use such non-serialized Software on any 
number of Computers for demonstration, evaluation, and training purposes only and only if any Output Files 
or other material produced through such use are used only for internal, non-commercial, and non-production 
purposes.  You may not use such non-serialized Software after any applicable timeout period has ended, 
unless you input a valid serial number. ACCESS TO AND USE OF ANY OUTPUT FILES CREATED WITH 
SUCH NON-SERIALIZED SOFTWARE IS ENTIRELY AT YOUR OWN RISK. 

     2.1.2 
The Software, or portions of the Software, that are provided with a serial number designated for “evaluation 
purposes” or other similar designation (such as Software or a serial number supplied as “EVAL” under a 
separate ordering document) and that includes an expiration date (“Evaluation Software”) may only be 
installed and used on Computers for demonstration, evaluation, and training purposes only and only if Output 
Files or other materials produced through such use are used only for internal, non-commercial, and non-
production purposes.  The Evaluation Software will automatically time out with or without prior notice.  You 
may not use such Evaluation Software after any applicable time-out period has ended, unless you input a 
valid serial number. USE OF ANY OUTPUT FILES CREATED WITH SUCH NON-SERIALIZED SOFTWARE 
IS ENTIRELY AT YOUR OWN RISK. 
 
2.1.3  General Use 
Except as described otherwise herein, you may install and use one (1) copy of the Software in accordance 
with the Documentation only on the Permitted Number of your compatible Computers into which you enter a 
valid serial number. 
 
2.1.4  Distribution from a Server  
The Software may not be distributed from a Server or an Internal Network. 
 
2.1.5  Dual Boot Platform 
The Software is licensed for use on a specific operating system platform.  You must purchase a separate 
license for use of the Software on each operating system platform.   
 
2.1.6  Documentation 
You may make copies of the Documentation for your own internal use in connection with use of the Software 
in accordance with this Agreement but no more than the amount reasonably necessary.  Any permitted copy 
of the Documentation that you make must contain the same copyright and other proprietary notices that 
appear on or in the Documentation. 

3.  Intellectual Property Ownership 
The Software and any authorized copies that you make are the intellectual property of and are owned by MetLogix 
Incorporated.  The structure, organization, and source code of the Software are the valuable trade secrets and 
confidential information of MetLogix Incorporated.  The Software is protected by law, including but not limited to the 
copyright laws of the United States and other countries, and by international treaty provisions.  Except as expressly 
stated herein, this Agreement does not grant you any intellectual property rights in the Software and all rights not 
expressly granted are reserved by MetLogix Incorporated. 



 

 

4.  Restrictions and Requirements 

   4.1  Notices 
Any permitted copy of the Software that you make must contain the same copyright and other proprietary 
notices that appear on or in the Software. 

   4.2  Use Obligations 
You agree that you will not use the Software other than as permitted by this Agreement and that you will not use 
the Software in a manner inconsistent with its design or Documentation. 

   4.3  No Modifications 
You may not modify, port, adapt, or translate the Software. 

   4.4  No Reverse Engineering 
You will not reverse engineer, decompile, disassemble, or otherwise attempt to discover the source code of the 
Software.   

   4.5  No Unbundling 
The Software may include various applications, utilities, and components, may support multiple platforms and 
languages, and may be provided to you on multiple media or in multiple copies.  Nonetheless, the Software is 
designed and provided to you as a single product to be used as a single produce on Computers permitted by 
Section 2.  You are not required to install all component parts of the Software, but you may not unbundle the 
component parts of the Software for use on different Computers.  You may not unbundle or repackage Software 
for distribution, transfer, or resale. 

   4.6  No Transfer 
YOU WILL NOT RENT, LEASE, SELL, SUBLICENSE, ASSIGN OR TRANSFER YOUR RIGHTS IN THE 
SOFTWARE, OR AUTHORIZE ANY PORTION OF THE SOFTWARE TO BE COPIED ONTO ANOTHER 
INDIVIDUAL OR LEGAL ENTITY’S COMPUTER EXCEPT AS MAY BE EXPRESSLY PERMITTED HEREIN.  
You may, however, permanently transfer all your rights to use the Software to another individual or legal entity 
provided that: (a) you also transfer (i) this agreement, (ii) the serial number(s), the Software affixed to medial 
provided by MetLogix or its authorized distributor, and all other software or hardware bundled, packaged, or pre-
installed with the Software, including all copies, Updates, and Prior Versions (as defined in Section 5); (b) you 
retain no Updates, Prior Versions, or copies, including backups and copies stored on a Computer; and (c) the 
receiving party accepts the terms and conditions of this agreement and any other terms and conditions under 
which you purchased a valid license to the Software.  NOTWITHSTANDING THE FOREGOING, YOU MAY 
NOT TRANSFER EDUCATION, PRE-RELEASE, EVALUATION SOFTWARE, OR NOT FOR RESALE COPIES 
OF THE SOFTWARE OR SOFTWARE OBTAINS UNDER A METLOGIX VOLUME LICENSE PROGRAM 
EXCEPT AS MAY BE EXPRESSLY PERMITTED BY METLOGIX WITH THE TERMS OF A VOLUME LICENSE 
PROGRAM. 

   4.7  No Service Bureau 
You will not use or offer the Software on a service bureau basis. 

   4.8  MetLogix M Series Restrictions 
You may not use MetLogix M Series software on any non-PC device or with any embedded or device version of 
any operating system.   
 
 



 

 

5.  Updates 
If the Software is an Update to a prior version of MetLogix software (the “Prior Version”), the following apply: 
 
Your use of this Update is conditional upon your retention of the Prior Version.  Therefore, if you validly transfer this 
Update pursuant to Section 4.6, you must transfer the Prior Version along with it.  If you wish to use this Update in 
addition to the Prior Version, you may only do so on the same computer on which you have installed and are using 
the Prior Version.  Any obligation that MetLogix may have to support Prior Versions may end upon the availability of 
this Update.  No other use of the Update is permitted.  Additional Updates may be licensed to you by MetLogix with 
additional or different items. 

6.  Limited Warranty 
MetLogix warrants to the individual or entity that first purchases a license for the Software for use pursuant to the 
terms of this agreement that the Software will perform substantially in accordance with the Documentation for the 
ninety (90) day period following receipt of the Software when used on the recommended operating system and 
hardware configuration.  Non-substantial variation of performance from the Documentation does not establish a 
warranty right.  This limited warranty does not apply to the following which are made available “AS-IS” and without 
warranty from MetLogix: patches, font software; pre-release (beta), trial, starter, evaluation, product sampler, and not 
for resale (NFR) copies of the Software including but not limited to Evaluation Software.  All warranty claims must be 
made, along with proof of purchase, to MetLogix within such ninety (90) day period.  If the Software does not perform 
substantially in accordance with the Documentation, the entire liability of MetLogix and its affiliates and your 
exclusive remedy will be limited to either, at MetLogix’ option, replacement of the Software or refund of the license 
fee you paid for the Software (if any).  THE LIMITED WARRANTY SET FORTH IN THIS SECTION GIVES YOU 
SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE ADDITIONAL RIGHTS UNDER LAW WHICH VARY FROM 
JURISDICTION TO JURISDICTION.  METLOGIX DOES NOT SEEK TO LIMIT YOUR WARRANTY RIGHTS TO 
ANY EXTENT NOT PERMITTED BY LAW. 

7.  Disclaimer 
THE LIMITED WARRANTY IN SECTION 6 IS THE ONLY WARRANTY OFFERED BY METLOGIX, ITS 
AFFILIATES, AND SUPPLIERS AND IT STATES THE SOLE AND EXCLUSIVE REMEDIES FOR METLOGIX’, ITS 
AFFILIATES’, OR SUPPLIERS’ BREACH OF THAT OFFERED WARRANTY.  THE LIMITED WARRANTY IN 
SECTION 6 AND ANY STATUTORY WARRANTY AND REMEDY THAT CANNOT BE EXCLUDED OR LIMITED 
UNDER LAW ARE THE ONLY WARRANTIES APPLICBLE TO THE SOFTWARE.  OTHER THAN THOSE 
OFFERED AND STATUTORY WARRANTIES APPLICABLE TO THE SOFTWARE, METLOGIX, ITS AFFILIATES, 
SUPPLIERS, AND CERTIFICATE AUTHORITIES DISCLAIM ALL WARRANTIES, CONDITIONS, 
REPRESENTATIONS, AND TERMS, EXPRESSED OR IMPLIED, WHETHER BY STATUTE, COMMON LAW, 
CUSTOM, USAGE, OR OTHERWISE AS TO ANY MATTER, INCLUDING BUT NOT LIMITED TO PERFORMANCE, 
SECURITY, NON-INFRINGEMENT OF THIRD PARTY RIGHTS, INTEGRATION, MERCHANTABILITY, 
SATISFACTORY QUALITY, AND FITNESS FOR ANY PARTICULAR PURPOSE.  OTHER THAN SUCH OFFERED 
AND STATUTORY WARRANTIES AND REMEDIES, METLOGIX, ITS AFFILIATES, SUPPLIERS, AND 
CERTIFICATE AUTHORITIES PROVIDE THE SOFTWARE AND ACCESS TO ANY WEBSITES, METLOGIX OR 
THIRD PARTY ONLINE SERVICES, AND CERTIFICATE AUTHORITY SERVICES AS-IS AND WITH ALL FAULTS.  
THIS DISCLAIMER OF WARRANTY MAY NOT BE VALID IN SOME JURISDICTIONS.  YOU MAY HAVE 
ADDITIONAL WARRANTY RIGHTS UNDER LAW WHICH MAY NOT BE WAIVED OR DISCLAIMED.  METLOGIX 
DOES NOT SEEK TO LIMIT YOUR WARRANTY RIGHTS TO ANY EXTENT NOT PERMITTED BY LAW.   

8.  Limitation of Liability 
EXCEPT FOR THE EXCLUSIVE REMEDY OFFERED BY METLOGIX ABOVE AND ANY REMEDIES THAT 
CANNOT BE EXLCUDED OR LIMITED UNDER LAW, METLOGIX, ITS AFFILIATES, SUPPLIERS AND 
CERTIFICATE AUTHORITIES WILL NOT BE LIABLE TO YOU FOR ANY LOSS, DAMAGES, CLAIMS, OR COSTS 
WHATSOEVER INCLUDING ANY CONSEQUENTIAL, INDIRECT OR INCIDENTAL DAMAGES, ANY LOST 
PROFITS OR LOST SAVINGS, ANY DAMAGES RESULTING FROM BUSINESS INTERRUPTION, PERSONAL 
INJURY OR FAILURE TO MEET ANY DUTY OF CARE, OR CLAIMS BY THIRD PARTY, EVEN IF ANY METLOGIX 



 

 

REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSS, DAMAGES, CLAIMS, OR 
COSTS.  IN ANY EVENT, METLOGIX’ AGGREGATE LIABILITY AND THAT OF ITS AFFILIATES, SUPPLIERS, 
AND CERTIFICATE AUTHORITIES UNDER OR IN CONNECTION WITH THIS AGREEMENT WILL BE LIMITED 
TO THE AMOUNT PAID FOR THE SOFTWARE, IF ANY.  THIS LIMITATION WILL APPLY EVENT IN THE EVENT 
OF A FUNDAMENTAL OR MATERIAL BREACH OR A BREACH OF THE FUNDAMENTAL OR MATERIAL TERMS 
OF THIS AGREEMENT 
 
THE FORECOING LIMITATIONS AND EXCLUSIONS APPLY TO THE EXTENT PERMITTED BY APPLICABLE 
LAW IN YOUR JURISDICTION.  THIS LIMITATION OF LIABILITY MAY NOT BE VALID IN SOME JURISDICTIONS.  
YOU MAY HAVE RIGHTS THAT CANNOT BE WAIVED UNDER CONSUMER PROTECTION AND OTHER LAWS.  
METLOGIX DOES NOT SEEK TO LIMIT YHOUR WARRANTY OR REMEDIES TO ANY EXTENT NOT 
PERMITTED BY LAW. 

9.  Export Rules 
You acknowledge that the Software is subject to the U.S. Export Administration Regulations and other export laws, 
restrictions, and regulations (collectively the “Export Laws”) and that you will comply with the Export Laws.  You will 
not ship, transfer, export, or re-export the Software, directly or indirectly, to: (a) any countries that are subject to US 
export restrictions (currently including, but not necessarily limited to, Cuba, Iran, North Korea, Sudan, and Syria) 
(each, an “Embargoed Country”), (b) any end user who you know or have reason to know will utilize them in design, 
development or production of nuclear, chemical or biological weapons, or rocket systems, space launch vehicles, 
and sounding rockets, or unmanned air vehicle systems (each, a “Prohibited Use”), or (c) any end user who has 
been prohibited from participating in U.S. export transactions by any federal agency of the U.S. government (each, a 
“Sanctioned Party”).  In addition, you are responsible for complying with any local laws in your jurisdiction which may 
impact your right to import, export or use the Software.  You represent and warranty that (i) you are not a citizen of, 
or located within, an Embargoed Country, (ii) you will not use the Software for a Prohibited Use, and (iii) you are not 
a Sanctioned Party.  All rights to use the Software are granted on condition that such rights are forfeited if you fail to 
comply with the terms of this agreement. 

10.  General Provisions 
If any part of this Agreement is found void and unenforceable, it will not affect the validity of the balance of this 
Agreement, which will remain valid and enforceable according to its terms.  This Agreement may only be modified in 
writing, signed by an officer of MetLogix, Inc.  The English version of this Agreement will be the version used when 
interpreting or construing this Agreement.  This is the entire Agreement between MetLogix and you relating to the 
Software and it supersedes any prior representations, discussion, undertakings, communications, or advertising 
relating to the Software. 

11.  Notice to U.S. Government End Users 
For U.S. Government End Users, MetLogix agrees to comply with all applicable equal opportunity laws including, if 
appropriate, the provisions of Executive Order 11246, as amended, Section 402 of the Vietnam Era Veterans 
Readjustment Assistance Act of 1974 (38 USC 4212), and Section 503 of the Rehabilitation Act of 1973, as 
amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-250, and 60-741.  The affirmative action 
clause and regulations contained in the preceding sentence will be incorporated by reference in this Agreement. 

12.  Compliance with Licenses  
If you are a business, company, or organization, you agree that, in addition to any license compliance checking 
performed by the Software, MetLogix or its authorized representative have the right, no more than once every twelve 
(12) months, upon ten (10) days’ prior notice to you, to inspect your records, systems, and facilities to verify that your 
use of any and all MetLogix software is in conformity with your valid licenses from MetLogix.  For example, MetLogix 
has the right to those of your records useful to determine whether installations of the Software have, or have not, 
been serialized, and you shall provide such records to MetLogix promptly upon request by MetLogix.  Additionally, 
you shall provide MetLogix with all records and information requested by MetLogix in order to verify that your use of 



 

 

any and all MetLogix software is in conformity with your valid licenses from MetLogix within thirty (30) days of 
MetLogix’ request. 

13.  Peer to Peer Communications 
The Software may use your connection to a local area network, without additional notice, automatically connect to 
other MetLogix software and, in doing so, may indicate on the local area network that it is available for 
communication with other MetLogix software.  These connections may transmit the IP Address of your connection to 
the local network but no personally identifiable information is ever transmitted or received through such network 
connections (except to the extent that IP addresses my be considered personally identifiable in some jurisdictions). 
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